2D Sediment Workshop

1 Objective

In this workshop, you will use HEC-RAS to setup a simple 2D sediment simulation.

2 Introduction

The workshop is based on a series of laboratory experiments conducted by Weise (2002).
The experiments were designed to study contraction scour and expansion deposition of non-
uniformly sized sediment. The experiment consists of a 16.5-m long rectangular flume with
a variable with between 0.5 m and 1 m. The straight side of the flume is a smooth glass
while the curved side with rough concrete. The initial bed had a 20-cm layer of fine gravel
with a 5.5 mm mean diameter and geometric standard deviation 1.47. The upstream flow
was 0.15 m3/s and the downstream water depth was 0.312 m. The experiment duration
was 125 min.

3 Workshop Instructions

3.1 Open the RAS Project

The HEC-RAS project is named Weise.prj and should be contained in a folder names
2D Sediment Workshop.

3.2 Geometry

The workshop already contains a terrain, computational mesh, boundary condition
lines and Manning’s n layer. The grid resolution utilized for this workshop is
relatively coarse but is utilized for computational efficiency. It is always
recommended to start with a coarse grid resolution to get the model running and
narrow down on the model parameters and settings, and then increase the model
resolution before doing production runs. Sediment transport has a lot of options and
parameters to calibrate, so being able to speed up the initial exploratory calibration
runs is very useful. Once the calibration options and parameters have been
narrowed down, the resolution can be increased to finalize the calibration and do the
validation runs. For this model, Manning’s polygons have been defined in order to
specify different roughness coefficients for the flume walls. The roughness is utilized
in the hydrodynamic model at faces while in sediment at cells. Because the model
only uses a single value extracted from the cell centroids and face centers, it is
important the Manning’s polygons extend into the first cell/face right next to the
walls.
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3.3

File Project Tools Help

Selected Layer: Boundary Condition Lines @ LhOAxN e EMA D v e -

]ZSDFJ\;wﬁ;s ol [T & Tooks - | 2 Editing: 'Boundary Condition Lines'

“HFeiess [

Flow Data

A
Open the Unsteady Flow editor £| The boundary condition lines have already been
defined as Upstream and Downstream.

Select Location in table then select Boundary Condition T
River Reach RS Boundary Condition

Storage /2D Flow Areas Boundary Condition
1| 2DArea BCLine: Downstream ’

2| 2DArea BCLine: Upstream .

Click on the Downstream BCLine and select ___>t=a¢ Hydrograph |

Set a constant downstream stage at 0.312 m

(Note: you can set a constant downstream stage by repeating the stage - or flow in
the next step - in the time series.)

It is usually best practice in 2D modeling to Use Initial Stage with a downstream
Stage boundary Condltlon. v Use Initial Stage (recommended)

Click on Upstream BCLine and select "o Hydrograph |

Set the flow to 0.15 m3/s

Also set the EG Slope to 0.001 for distributing flow along BC Line and select TW
Check.

EG Slope for distributing flow along BC Line: ID-DDI v Tw Check
PlotData | ok | Cancel

It is not necessary to set the initial water surface since the model will use the
downstream stage to initialize the model.

Save As and give it a name (e.g. “2D Sediment”)
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3.4 Sediment Data

3.4.1 Define Bed Gradation Polygon in Mapper

Before you define sediment data, it is useful to define the spatial distribution of your
bed gradations in Mapper (so you can populate them with gradation data in the
sediment editor).

Open Mapper, and Right Click on Map Layers. Select Create a New RAS
Layer>Sediment Bed Material Layer.

=l [#] Geometries
- [v] 20 Sediment Workshop

-] Event Conditions

--[] Results
> 2 N

. B[] Mannings_r @ Add Web Imagery...
=[] Terrains
. 7] Terrain_ Wit Reference Layers »
|*b Create a New RAS Layer 2 | Land Cover Layer
e Add an Existing RAS Layer » Soils Layer
g( Manage Geometry Associations ... | Sediment Bed Material Layer |

Infiltration Layer From Land Cover / Soils Layers

Infiltration Layer From Shapefile »

Elevation Peint Layer

1 Profile Lines migrated to Profile Lines under the F B Calculated Layer

You can press No to the question about spatial reference system.
This editor was developed to import layer data from raster or shape files.

But we are just going to draw a singly polygon, so you will press the Create Empty button.
Create Empty

Press the folder if you want to change the name to something other than the default
“Sediment Bed Material.”

Filename: |d:\ .ASediment Bed Material hdf =

ons can be added later Create Emphy | Cancel |

.

Expand the Association Editor that comes up until you can see the Sediment Bed Material
Layer dropdown menu.

Select the empty Sediment Bed Material layer you just created.
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Manage Layer Associations X

| Temain | Manning'sn | Infiltration | % Impervious ediment Bed Material Laye
Temain_With_Walls_Op... »| MNone)  v| (None) v| (Nome) v |[fiNone) =

Sediment Bed Material

Type | RAS Geometry Layers
Geometry |2D Sediment Workshop

Start editing the Classification Polygons in this new layer, choose the draw tool « i , and
draw a polygon around the mesh.

Give the Polygon a Classification Name (e.g. "Bed Gradation”).

1 [#] Geomelries
[¥] 2D Sediment Workshop .
[] Event Conditions
- [] Results
= MapLayBs
[[] Mannings_n
- [¥] Sediment Bed Material 1
. [#] Classificalion Polygons B Classifications
=[] Temains

L[] Terrain_With_walls_0p01m [ NN |

Classification Name: IBed Gradation

|1 Profile Lines migrated to Profile Lines under the F |

Stop Editing @ and save the classification.

Associate this Bed Material Classification with the geometry file by right clicking on the
Geometries tree node and selecting Manage Geometry Association.

v
Manage Layer Associations

Type RAS Geometry Layers Termrain Manning’s n Infiltration Sediment Bed Material Layer

Impervious
2D Sediment Workshop Temain_With_Walls_0p LI Mannings_n ;I (None) LI (Mone) ;I

Warning Current versions of RAS have a glitch that can make this step difficult.

The Layer Association Manager opens too small so you cannot see or scroll to the Sediment
Bed Material Layer. Drag the right edge to expand the editor and see the last column or
make the column headers thinner until you see all the columns.

Manage Layer Associations X
| RAS Geometry Layers — roron P Varrings n Infration % Impervious
2D Sediment Workshop Temain_With_Walis_Op... v || (None) = (None) = || (None)
Results sim Temain_With_Walls_0Op... ;l (None) (None) (None)
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Then the Sediment Bed Material Layer selection does not always save.

Reopen the Geometry Association Manager to make sure if it is selected.

If it isn't — reselect it, and then click on the Terrain drop down.

Reselecting the current terrain should get it to save.

3.4.2

3.4.3

Basic Options
5E_I:l

Open Sediment Data editor by clicking on the icon from the main RAS window.

This window opens to the Boundary Conditions Tab, click on 2D Bed Gradations
to start there.

'V
| File Options  View Help

|
1 Boundary Conditions] 20 Bed Gradations
Transport Function:  |Wu - Define/Edit
Bed Gradation ...
Active Layer -

Sorting Method:

Fall Velodity Method: |Soulsby - iz - ED)

Set the Transport Function to Wu, the Sorting Method to Active Layer, and the
Fall Velocity Method to Soulsby as shown in the screenshot below.

Notes: The only Sorting Method supported by the 2D sediment model is the Active
Layer. Choosing any other sorting method will default back to the Active Layer
method.

Bed Gradation

Define [Edit ‘

From the Sediment Data editor press _5ed Gradation ... |

Create a new Bed Gradation by pressing the "New” button g Give it a name
(e.g. “"Nonuniform”). Enter the gradation information as shown in the figure below.

Since the grain size distribution is moderately well sorted, the fractions are contained
within only two grain classes. This is relative few. One of the improvements which
could be done to the model is to specify User-defined grain classes with more
resolution in the range utilized in the experiment, so that more grain classes are
utilized.
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I Bed Gradation o U X
View Help
Bed Gradation Template: [ Nonuniform = gl i’ il Enter Multiple Gradations in a Table... |
Class| diam (mm) % Finer ; .
1|Clay 0.004 100 Legend a
2|VFM 0.008 Gradation Curve
3|FM 0.016
4|MM 0.032 301
5|CM 0.0625
6|VFS 0.125
7|FS 0.25
8|Ms 0.5 s0-
9|Cs 1 E
10{VvCs 2 0 [
11|vFG 4 22 #
12|FG 8 100 40
13| MG 16
14|CG 32
15| VCG 64
16|SC 128 204
17|LC 256
18|SB 512
19|MB 1024
2018 2043 0 .
(* %Finer (" GrainClass %  Convert: | 2 5 10
Yefiner<—>% Grain Size (mm) J
L] |
[~ Set Sample Specific Cohesive Parameters
oK | Cancel |

3.4.4 Transport Method Options
From the Sediment Data editor, click on Options | Transport Methods...

W Sediment Data - Weis sed

File = Options  VYiew Help

User Defined Grain Classes ...
Set Cohesive Options ...

Bed Change Options (10)...
Transport Methods...

Bou

Under AD Parameters, set the Load Correction Factor Options.

20 Methods;

AD Parameters T Erozion Parameters ]

Load Corection Factor

v Tatalload Comrection Factor

Bed-Load Carrection Factar: I\-"an Rijn-afu ;l

Suzpended-Load Comrection: IE:-:pDnentieﬂ Caonc Profile ;I

In the Adaptation Coefficient section, set the Total-load method to Total Length
and specify a value in the editor of 0.2 m as shown in the screenshot below.
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B3 Transport Model and AD Parameters: — O x

10 Routing Method: Continuity ﬂ

20 Advection-Diffuzion kethods:

Adaptation Coefficent

Total Load: |T|:|tal Length j
Tatal Length: |0 4 m
Suspended Adaptation Coefficient: |':':'”3t‘5'”t Coef J
Conztant Coefficient
Bed Load Adaptation Length: |E|:|nstant Length J
Length ft

Click on OK, and save your changes in the Sediment Data editor.

3.4.5 2D Sediment Options

In the Sediment Data editor lick on the menu Options | 2D Options as shown in
the screenshot below.

W Sediment Data - 2D Sediment

File | Options View Help

! Initiz User Defined Grain Classes ...
............. Set Cohesive Options ...

Bed Change Options...

Bed Change Opticns (New]...

Transport Methods...

R Calibrate Transport Function...

. 20 Options [}

An editor called 2D Sediment Method will appear. This windows contains only 2D
specific sediment options.

In order to speed up the simulation, a Morphologic Acceleration Factor of 12.5
will be used. Since the experiment duration is 125 min, the equivalent
computational time representing 125 min of simulated bed change is computed as
125 min / 12.5 = 10 min. In general, it is not recommended to use Morphologic
Acceleration Factors larger than 20 or 30.
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=5

Sirulation Comparents: |,&|| Companents ﬂ
Sheet and Splash Erosion: |Nnne ﬂ
Erodibility: 1.

b orphological Acceleration Factor: 125

:

Baze Bed-Slope Coefficient;

Hindered Settling: e Ceiealen

L

Avalanching
™ Use dwalanching
Repoge dngle:

b airmum [terations:

11

Fielaxation Factor: 025

oK

Cancel |

3.4.6 Bed Mixing Options

From the Sediment Data editor click on the menu Options | Bed Mixing Options.

W Sediment Data - 2D Sediment

File = Options View Help

User Defined Grain Classes ...
Set Cohesive Options ...

Init

Bed Change Options...
Bed Change Options (New)...
Transport Methods...

E Calibrate Transport Function...

2D Options
Mon Mewtonian...
BSTEM Options...

Lateral Weir Options...

Bed Mixing Options ... I

In the Hiding Functions section, set the Hiding Function to Wu et al. the Hiding
Exponent to 0.6 as shown in the snapshot below.
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B3 Bed Mixing Options — O *

Capadty Partitioning (1D Only)
’7 Capacity Partitioning Method: I Bed Gradation Only LI % Inflow Gradation: |1|:|
Hi Functi ta for 1D
ding o T Shape Factor:
Hiding Function: I Wu et al LI Hiding Expanent: |g,5 |gl5

e Layer ons
Active Layer Thickness: I! dsd vl Multiplier: |3 Min Thickness: |0.5 m

Exchange Increment (1D Only): %t Bedload: |?°- %% Active Layer: |30

-

[~ Spedfy Seperate Cover/Active Layer Gradations

rovermcﬁve Layer Gradations (1D Only)

[~ Copeland Method Option (test) (1D Only) oK Cancel Defaults ...

Click on OK, to exit the editor and save your changes.

3.4.7 Sediment Boundary Conditions

From the Sediment Data editor, select the Boundary Conditions tab.

The interface automatically searches for boundary condition lines where sediment
data could be needed and list them in the table.

By default, any boundaries left unspecified are equilibrium boundary conditions, but
this option may also be specified by first select the white entry space and then
selecting the Equilibrium Load option (see snapshot below).

W Sediment Data — O X
File Options View Help

Initial Conditions and Transport Parameters ~ Boundary Conditions | USDA-ARS Bank Stability and Toe Erosion Model (BSTEM) | 2D Bed Gradations

Select Location for Sediment Boundary Condition

Add Sediment Boundary Location(s) | Delete Current Row | Define Sediment Split at Junction... |

sediment Boundary Condition Types

Rating Curve | Sediment Load Series | Equilibrium Load I Caparity Ratio | Clear Water {no Sed)

Flows Wtd Sed Split | Potential Wid Sed Splitl GC Threshald Split | Sed Split by GC |

2DArea:2DArea  |BCLine Downstream | Equilibriumn Load

Mixing Methods Selected Description : |
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3.4.8 Select Initial Bed Gradations

Next, select the bed gradations associated with each manning’s region.

Open the 2D Sediment Tab.

This will populate a row for each Manning’s n region in your geometry file.

This project only has one (base n). Click on the field next to it.

You will get a drop down menu including all of the bed gradations (again, just one in
this case) that you defined in Step 3.4.2.

Note: You may have to close the sediment file and open it if you do not see the “"Bed
Material Type.” If you still don't see it, make sure the classification polygon
saved and that the mapper association is correct.

W Sediment Data - Sed — O X
File Options View Help
Boundary Conditions] 2D Bed Gradations
Transport Function: |Wu v Define [Edit
Bed Gradation ...
Sorting Method: Active Layer -
Fall Velodity Method: |Soulsby | Definelayers... (20) E
| | Bed Material Type | Gradation
1|Bed Gradation Nonuniform LI
Non-erodible surface

3.5 Unsteady Flow Analysis

From the main HEC-RAS editor, open the Unsteady Flow Analysis editor by

clicking on

Click on the menu File | Save, and give the plan a name and Short ID.

In the section Programs to Run, select the checkboxes for Geometry
Preprocessor, Unsteady Flow Simulation, and Sediment.

Utilize today’s date for starting and ending dates. Start the simulation at 00:00
hours. The experiment duration is 125 min. However, since a morphologic
acceleration factor of 12.5 is used, the total simulation duration should be 125 min /
12.5 = 10 min.

A Unsteady Flow Analysis >
File Opticns Help

Plan: |2D Sediment Short ID: |20 Sediment

Geometry File: |2D Sediment Workshop

Unsteady Flow File: |2D sediment

Led Lef e

Sediment File: |2D sediment
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Programs to Run Plan Description
|¥ Geometry Preprocessor
¥ Unsteady Flow Simulation
Iv Sediment
T PostProcessor I

| Floodplain Mapping

Simulation Time Window

Starting Date: losbec201s  [F| Starting Time: oo
Ending Date: |08Dec20 16 J Ending Time: |00 20

Computation Settings
Computation Interval: 0.2Second ~ | J Hydrograph Output Interval: | 1 Minute v,
Mapping Output Interval: |30 Second | Detailed Output Interval: -

I Project DSS Filename: LI ]C:\Users \gOhecsag\Documents\Projects'\Classes'_ St Louis ﬂ

Compute

3.5.9 Flow Computation Options and Tolerances

In the Unsteady Flow Data editor, make the following changes to the
Options>Computation Options and Tolerances for the 2D Flow Area.

Because this dataset is a small scale laboratory dataset, the water surface and
volume tolerances should be reduced.

It is important to change the governing equations to the SWE. Use either the ELM or
EM solvers.

The other critical thing which the user should turn on is turbulence modeling.
The calibrated turbulence coefficients are provided below.

Since this is a relatively small dataset with only ~2700 cells, there is better to use a
small number of cores less or equal to 4 and not the default option of using all of the
cores.

Using too many cores can easily make this dataset run slower than with fewer cores.
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General] 2D Flow Options | 1D/2D Options | Advanced Time Step Control | 1D Mixed Flow Options

[~ Use Coriclis Effects (not used with Diffusion Wave equation)
| Parameter {Default) 2DArea
1| Theta (0.5-1.0) 1 1
| 2| Theta Warmup (0.5-1.0) 1 1
3| Water Surface Tolerance [max=0.08]{m) 0.01 0.001
|| 4|volume Tolerance (m) 0.01 0.001
5| Maximum Iterations 20 20
6 | Equation Set Diffusion Wave SWE-ELM (original/faster)
7| Initial Conditions Time (hrs) 0.03
& | Initial Conditions Ramp Up Fraction (0-1) 0.1 0.5
| | 9] Mumber of Time Slices {Integer Value) 1 1 |
10 | Turbulence Model Norel Conservative
11| Longitudinal Mixing Coeffident 0.3 0.3
12 | Transverse Mixing Coeffident . 1 0.1
13 | Smagorinsky Coefficent 0.05 0.05
14| Boundary Condition Volume Check r [
15 | Latitude for Coriolis {-30 to 90)
16 | Solver Cores All Available 2 Cores
17 | Matrix Solver PARDISO (Direct) PARDISO (Direct)
18 | Convergence Tolerance 0. 000 1 0.00001
19 | Minimum Iterations i
20 [ Maximum Iterations 30 30
21 |Restart Iteration 1t 10
22| Relaxation Factor 1.5 1.3
| 23| SOR Preconditioner Iterations 1] i |

| 0K Cancel Defaults ... | |

3.5.10 Sediment Computation Options and Tolerances

In the Unsteady Flow Analysis editor, select the menu Options | Sediment
Computation Options and Tolerances.

Sediment Computation Options and Tolerances ... %
Sediment Output Opticns ..
Sediment Dredging Options ...

On the General tab, set the Sediment Computation Multiplier to 5X the
hydraulic time step.

On the 2D Computational Options tab set the Advection Scheme to upwind.

We often change the Sediment Matrix Solver to speed models up, but we will
leave it for this short model.

Most models leave the Concentration Max Error and Concentration RSM Error
default, but because this is a flume model we will reduce these to 0.000001.

Layer thickness sets your vertical computational intervals. The defaults are set for a
river. So we need to reduce these for a flume to Initial=0.05m, Min=0.005m,
and Max=0.2m.
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HEC-RAS Sediment Computation Options and Tolerances

General | 2D Computational Options | | General 2D Computational Options |
1D Computational Options —= § =
Bed exchange iterations per time step (SPT) [0 Advection Scheme: | Upwind
Min bed change before updating Cross Section (ft): 0.02 |I Sedment Matrix Solver: | FeMRES-S0R
Min X5 change before recomputation of hydraulics (ft): W Implicit Sediment Weighting Factor:

[v Perform Volume Error Chedk/Carry Over: T Ty B S e

W “ul«_

Transport Energy Slope Method: | Downwind ﬂ Maximum # of Iterations:
= | ; . 0.000001 ‘
Sediment Computation Multiplier: 3 X the hydraulic time step Concentration Max Abs Error (mg/L): I |
Sediment Warmup Periods: | Concentration RMS Error (mg/L): 0.000001
C tration (2D Only): d |
oncentration ( niy) (ays) | Grain Class % Max Abs Error: IO'OO1
Gradation: (days) |
Computational Sediment Layer Parameters |
Bathymetry: (days) |
Layer Thickness (Optional):

Dynamic Bed Roughness
Bed Roughness Predictor: | Mone j

Initial (m) |0.1 Min (m)[0.05 Max {m)|0.2 |

# of Computational Layers (Optional): 5

Select Reaches to ‘ ‘
Average Bed Subgrid

Roughness Predictors | Subcell Erasion Method: | Constant LI

Subcell Deposition Method : | Veneer LI

Max Subgrid Regions (Optional): 1
Max Subgrid Length Scale (Optional):

Show XS Weights > Defaults ... Cancel ‘ oK | Show XS Weights >> |

Defaulis...| Cancel |

3.5.11 Sediment Output Options

3.6 Run the Model

Go back to the Unsteady Flow Analysis window and click on the compute button. The
model should start running and finish within a few minutes.

3.7 Open the Computation Log File

The computation log file contains detailed information on the model setup and
variable statistics during the simulation. This file is very important to look at when
running sediment. It contains detailed information on the sediment model setup,
initial and boundary conditions which should be checked to make sure everything is
correction.

3.8 View Results in RAS Mapper

Open RAS Mapper from the main HEC-RAS menu by clicking on ‘=i, Expand the
Results node and select the 2D area you just ran. Turn on the computational mesh.
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To add a 2D sediment output variable, right-click on the 2D area and select the
menu Add New RAS Results Map Layer.

£ ] Results
= [#] Weise B

RAS Results Information
Zoom to Layer

Remove Layer
Remove Layer and Delete Source Files

Maove Layer »

Open Folder in File Explorer

Show Compute Messages ...

|i Create a Mew Results Map Layer...
‘ Create a New Calculated Layer...

Manage Results Map Layers...
B ViewResultin 3D

E Results Map Parameters .
—Map Type — Unsteady Profile —Map Output Mode
Bl Hydraulics " Maximum Genersted for Current View (in memaol
E- Sediment  Minimum % Raster (with Associated Terrain)
[El- Sediment Bed ' B C Po ] P
ed Change % Profile Point Feature Layer: HI
Bed Hlevation AOECI0AE D000 Stored (saved to disk’
03DEC2016 00:00:00
Subeell Bed Change 00:  Raster based on Terrain: | Terain_with_Walls_0p01r_x |
Subcell Bed Elevation 08DEC2016 00:01.00 }
Variable Depth 02DEC201E 00:01-30 " Point Feature Layer: _@I
Hydraulic Bed Change %g%%:}g %g%% " Polygon Boundary at Value: ID
Hydraulic Bed Elevation DEDEC2016 DDDSDD
Subface Bed Change 08DEC2016 00:03:30
Subface Bed Elevation 08DEC2016 00:04:00 Map Type | Layer Name
[ Sediment Transport %g%g:}g % % % v
- Additonal 20 Variables
Map Type: A Map layer will be created for Bed change.
Map Mode: Map results are generated onthefly for the cument view. Add Map I Close

&) [#] Cell Bed Change |
{..[#] Cell Bed Change (028DEC2016 00:00-30)} — [ Smmm—m

: - [ Uniform Sed ¢ LayerProperties |
E|D Map Layers Edit Map Parameters
. []Manning's Polygons
. L[ Manni 1@  Zoomto Layer
C -0 ngs 2 ¥
= [v] Terains
. [#] Terrain_Wwith_\wialls_0p0im &0 Add Watch to Layer Values

Adjust the Color Ramp and for the dataset so that it can be visualized well in RAS
Mapper.

Below is an example of the computed bed change with a red-white-blue color ramp
with lower and upper limits set to -0.1 m and 0.1 m, respectively.
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0.100

0.000

-0.100

Try adding other 2D variables from both the Sediment Bed and Sediment
Transport Output Blocks.

3.8.12 Plot Time Series

El- ¥ Resulis

| B[] 20 Sediment \Workshop

[[] Event Conditions

[] Geometry

[] Depth (08DEC2016 00:00:00)
[ Velocity (0BDEC2016 00:12:00) All Enabled Results
[] \w/SE (08DEC2016 00:00:00) b Plot Time Series
V] Cell Bed Change

[ | Cell' Active Layer D

[ Cell Total-load Concentration
Map Layers

i--[] Mannings_n

Termains

[# Terrain_with_walls_0p01_ M |

WSE [Mo Enabled Maps with Profiles]
Velocity [No Enabled Maps with Profiles]
Depth [No Enabled Maps with Profiles]
Courant [Ne Enabled Maps with Profiles]

g RASMapper Plot - O X

Generic 2D Map
1 — 20 Sedime
0.06 1 - - i
= i
g ]
DG.Od 1
~J B
.E
£ i
= i
w
20,02
04 i i i
08Dec2016 08Dec2016 0004 08Dec2016 0008 0BDec2016 00
Time (12/8/2016)

3.8.13 Plot Profile

(1 [#] 2D Sediment WWorkshop
Cross Sections
2D Flow Areas

&

Profile Line 1

I Plet Tick Marks

Messages | Views IPmﬁle Ugﬂmwe Feature 4 | »
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Centerdine

3

Rename
2 Delete
X Import Polylines from Shapefile
™ PlotTic L _
:. SHP  Export All Profile Lines te Shapefile
M
=== SHP  Export Selected Profile Lines to Shapefile

(1.2522 -23613 T pixel =0.017/8'm) I

=

Bed Change on 'Centerline’

Value [m]

-0.10 1

Station [m]

Experiment with other results like Concentration.

Add “Depth” under the Hydraulics Results.
Compare it to the “Variable Depth” results.
How are they different?
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